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Welcome to another
PCLinuxOS Magazine Special Edition!!!

We have combined the nine Scribus installments into one,
easy­to­access PDF. If you are just finding out about
Scribus, you should have nearly everything you need in this
document in order to use Scribus.
A co­worker of mine recently wanted to try Scribus as an
open­source alternative to what she was using. It so
happened that I was already doing this series, so I had
always planned on a special edition. Now I can send the
whole thing to her, instead of sending it in installments.
I need to thank Paul Arnote for his help on a few of the
articles. He knows more about this program than I do, and
helped me iron out a few places. Thanks, parnote!
Also, we are publishing the magazine layout guide so that
Scribus users can put all of the previously mentioned
Scribus "lessons" together and see how they all fit together
to produce the final product. This layout guide is the
definitive source of information for the current magazine
layout, but the specs may change as the magazine's layout
changes and evolves.
I hope you find it useful.
Never stop learning!
Assistant Editor Meemaw
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by Meemaw
"I'm doing a newsletter at work, and I need a
desktop publishing application. I used to use
(Windows or Mac) Program X, but now that I've
changed to Linux, I need to know what's available."
Sound familiar? Never fear, we have the right
program for you: Scribus. From their website:
Scribus is an Open Source program that brings
award­winning professional page layout to
Linux/UNIX, Mac OS X, OS/2 Warp 4/eComStation
and Windows desktops with a combination of "press­
ready" output and new approaches to page layout.
Underneath the modern and user friendly interface,
Scribus supports professional publishing features,
such as CMYK color, separations, Spot Colors, ICC
color management and versatile PDF creation.
Why would you want to use Scribus? Scribus is
powerful software that helps you create great
looking documents of all kinds.
Oh, by the way, this magazine is made using
Scribus! The current stable version in the repos is
Ver. 1.3.9
Let's get started.
The start­up screen will be the first thing you see.
The first thing you want to do is to edit your page
properties. Your page properties will be for this
project only. The default settings are shown above.
You have the choice of single
page, double­sided, 3­fold or
4­fold. You can also put in
many other configuration items

such as your margins, paper size, portrait or
landscape orientation and even if you need more
than one page. If you aren't sure how many pages
you need, don't worry as you can add pages later.
You can also designate the unit of measure you
wish to use. We do the magazine using points, but
you can change it to inches, centimeters, or other
units you wish to use (I use inches at work). For our
example, I am keeping the defaults, except to
change the paper size to Letter. If you change your
mind about margins afterward you can go to File >
Document Setup and make your changes.
When you open your document, the default toolbar
should look as shown below.

From left to right, we have New, Open, Save, Close,
Preflight Verifier, Convert to PDF, Undo, Redo, Cut,
Copy, Paste, Selection, Create Text Frame, Create
Image Frame, Create Render Frame, Create Table,
Insert Shape, Insert Polygon, Insert Line, Insert
Bezier Curve, Insert Freehand Line, Rotate Item,
Zoom In or Out, Edit Contents of Frame, Edit Text,
Link Text Frames, Unlink Text Frames,
Measurements, Copy Item Properties and Eye
Dropper. Insert Shape and Insert Polygon each have
drop down menus so you can designate the type of
object you want to insert.

The two extra windows open at right are Document
Properties and Layers. I have these open all the
time because most of the design is done using these

windows. If you mess up
and close one, you can
always go to the menu bar
and click on Windows. You
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will see a whole list of windows you can use; just
click on the one you want. We'll use a few more of
these soon. Also, at the bottom of your main window
you will see a few other handy things... zoom, page
navigation, level navigation and preview mode
(looks like an open eye).
Items are added to your document by the use of
frames. If you want text, add a text frame. If you
want to place a picture, add an image frame and put
the picture in it. Let's start by adding a text frame.
From your toolbar, click on the Create Text Frame
button (it looks like a piece of paper with a big A in
the corner). Then click and drag to make a rectangle
on your page.
Don't worry if it isn't the right size or in the right spot,
but notice that the text in the Properties window that
was grayed out before is now suddenly 'active' and
the boxes are filled with numbers. The Properties

window is where you can configure each item you
put into your document. Using this window you can
not only make your items the right size, but also
place them exactly where you want them, which is
much easier than trying to place it with the mouse.
I want my text box edges to be exactly on my top
and left margins, so I will set the X­Pos and Y­Pos
both at 40 pt – right where I set my margins. In many
newsletters, the size of the text box will generally
depend on the length of the article, so I will leave the
height and width alone for now.
On your toolbar, you saw a button that looked like a
notepad with a pencil on it toward the right end. With
your text box selected as in the above picture, click
on the notepad ­ that is the Story Editor tool, and will
give you the window shown below (or right click
inside the text frame and choose Edit Text from the
context menu):

This is the Story Editor window. You can use it to
write your article or, if you have a text document that
you want to use, you can copy and paste the text

into this window. When you click on the green check
mark in the top row, the window will close and your
text will be in the text frame. All of your text frames
will be filled in this manner.
You can add graphics too. Click the Create Image
Frame button and click and drag, just like you made
your text frame.

To insert the image, right­click
somewhere in the frame and
choose Get Image­­­­>
When it is inserted, you can
configure it. You can right click
on the image and choose Fit
Image to Frame. That choice
will shrink your image down to
fit within the frame you have
drawn, but it may not fit
precisely. If you know what size

Using Scribus, Part 1: Getting Acquainted
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your image needs to be you can enter those
numbers into the dimensions in the Properties
window. You can also choose Fit Frame to Image,
which changes the frame so it is exactly the same
size as the image.

Let's look at the Properties window again.
Everything can be configured using this
window. The sections in the window are
X,Y,Z, Shape, Group, Text, Image, Line
and Colors.
X,Y,Z is the one you see and use most
often. It is the one you use for size and
placement of your frame. You can raise or
lower your frame from the arrows under
'Level' (which helps if you have two pictures
that overlap.) Notice also the button at right
that looks like a lock: it is used for 'locking'
an item in a certain spot. This is particularly

helpful when you have several frames and some
need text wrapped around them. If you lock the
frame, it won't move accidentally and you can go on
and work with something else.
Shape is for text wrap. After you put in a picture and
get it placed correctly, you can set the shape so the
text wraps around the picture and can all be seen.
Group ­ Group is used to set text flow around a
group of objects (rather than Shape for an image).

Some of the things you use may be
shapes that have been grouped
together, and this is supposed to
configure the text flow. However, it
doesn't work correctly quite yet in the
more recent versions of Scribus, so in
later articles, we'll look at ways to
accomplish that another way.
Text is where you will configure your
text. Font and size are configured
here, as well as color and text effects.
If you want a big title with blue text
outlined in red, you can do that here.
There are text configuration items in
the text editing window that you can
use, but you really should do most of
it from the Text tab in Properties.
We'll explore that in a later article as
well.
Line ­ If you want your text or image
frame to have a border, you can
configure it here. You are given many
line styles and sizes. Before you can
see it, however, you must go to
Colors and choose a color, as the

default is none.
Colors ­ Here you configure the color of any object
you insert (although text color is configured in the
Text tab). If you insert a rectangle for decoration,
you can choose the border and fill color and also the
transparency. Horizontal and vertical gradients can
be configured as well.
We can start our newsletter next month.

Using Scribus, Part 1: Getting Acquainted
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by Meemaw
In Part 1, we became familiar with some of the
Scribus tools, learning how to open a new document
and format the page. We also learned about frames
and how to add a text frame and an image frame.
Those are the basics to starting a poster, newsletter
or brochure.
Since the majority of my work in Scribus is the
magazine and the newsletter at work, we should go
through the steps for creating a newsletter. (The
magazine just has more pages). Before you start
adding text frames randomly to a page, you will
probably need to do a little planning. Decide on
these beforehand:
1. Page size ­ Is this something you are going to
print out and mail? What size paper will be the best?
For my newsletter at work, the answer is yes, they
will be printed and mailed, and letter size is what I
use.
2. Orientation ­ Will it be more easily read in portrait
or landscape? My newsletter is portrait, but since the
magazine is read mostly from a computer screen,
we find that the most popular orientation is
landscape.
3. Margins ­ You can make really small margins if
you want, but if it is to be printed, your printer
may not be able to print them, especially the
bottom margin. You also want to stay away from
filling up every available space on the page as it
can make your newsletter harder to read.
4. Design ­ Are you going to have some sort of
title header on page 1? How big do you want it,

and what will it look like? If you are printing it, will it
be in color or just black?
When you get an idea of your layout and design, it's
time to start. For this article, the newsletter will be
letter size, portrait orientation, with 0.25 inch margins
and a small header on each page. The bottom
margin will be 0.5 inch to accommodate my printer.
Open a new document, making it letter­size, portrait
and 0.25 inch margins at left right and top, and a 0.5
inch margin at bottom..

So, now our page is ready.

Newsletters can be just text,
but a title header catches the
reader's eye. Let's do a title
header on the first page.
Click on the shape tool, and
draw a rectangle. In the
Properties window, set the
width to 8 inches and the
height to 1 inch, the set the
X­Pos and Y­Pos each to
0.25 inches (your margins). If
you haven't named and
saved your file yet, you
should probably do that.

The default color is black.
We want to change that, so
click on Colors (at the bottom
of the properties window)

Using Scribus, Part 2: Starting the ProjectUsing Scribus, Part 2: Starting the Project
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and assign a color. I used blue. Make sure the 'fill'
button is clicked (looks like the pouring paint
bucket.) You can also use a gradient; it is in the
drop­down above the list of colors. The one I used
was a vertical gradient. When you choose gradient,
it opens another item, which is the box where you
configure your gradient. Notice I have configured
one 'end' of the gradient blue, and the other white.
The red triangle under the gradient configuration
tells which color you are changing. On a vertical
gradient left is top and right is bottom. If you want a
border too, you should click the 'line' button (looks
like the paintbrush) and set it there.
I set my border to None. (Save)

I wanted rounded corners on my rectangle, so I
clicked on Shape in the Properties box, and set the

measurement on Round Corners (top of window) to
0.3500. The higher your number is, the more
rounded your corners will be.
From there, I messed around a little more and made
another rectangle, this time with a radial gradient. I
wanted it in the exact center of the other gradient, so
I clicked on Window > Align and Distribute so I can
center everything. Click on the bigger rectangle first,
then, holding down the Shift key, click on the smaller
rectangle. In Align and Distribute, you will see
'Relative to' and a drop­down next to it. It should say
'First selected' ­­ if it doesn't, change it using the
drop­down. The click

on the two
centering
buttons (each
in the center
of their
respective
lines.) You
can also
choose to
center an
object on the
page,
changing the 'Relative to' drop­down to
Page. (Save your work.)

If you are happy with what
you have done, you
should lock it down so you
don't move or resize it by
accident. Click outside
both rectangles, and drag
a rectangle shape. You
should be able to see a
rectangle surrounding your
header. Let the button up
on your mouse, and you
will see that both
rectangles have been
selected. You can select
them one at a time like we
did before, but if your hand
shakes at all you may
move one by mistake and
have to go back and align
again.......
In your properties box, go
back to X,Y,Z and you
should see two buttons in

the center that aren't grayed out. One has the outline
of several shapes and the other is the lock. The first
one is the 'Group' button, which you can use to
make the rectangles into one item that is combined.
When you do that you can move them both just by

grabbing one of them. If you have a group
you want to copy and use over and over,
this is a benefit. Click on Group, then click
on the Lock. The lock does just that ­ locks
your item in place so it can't be moved or
changed by accident. The icon will change
from an open lock to a closed one. (Save)
Now we want our title. Click on the text

Using Scribus, Part 2: Starting the Project
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frame button and make a rectangle over your
header. Click on the 'Edit Text' button on the toolbar,
or right­click in the text frame and choose Edit Text.
There are many configurations in the Story Editor
window but they don't always stay, so we do most of
that from the Text section of the Properties window.
You can do loads of things with your text. Choose
your header, then your text and center the text, left
to right, then lock it in place. You will probably get a
message that some of you objects are locked. We
know that because we locked the rectangles down
earlier, so click on 'Skip Locked Objects' and the text
will be centered in the rectangles. You also want to
save your file again.

You can start adding text frames with news stories
and image frames for pictures if you wish. Next
month we'll explore more of how to get our
newsletter looking the way we want.

Using Scribus, Part 2: Starting the Project

1. All the contents of the NEW PCLinuxOS Magazine are only
for general information and/or use. Such contents do not
constitute advice and should not be relied upon in making (or
refraining from making) any decision. Any specific advice or
replies to queries in any part of the magazine is/are the
person opinion of such experts/consultants/persons and are
not subscribed to by the NEW PCLinuxOS Magazine.

2. The information in the NEW PCLinuxOS Magazine is
provided on an "AS IS" basis, and all warranties, expressed
or implied of any kind, regarding any matter pertaining to any
information, advice or replies are disclaimed and excluded.

3. The NEW PCLinuxOS Magazine and its associates shall not
be liable, at any time, for damages (including, but not limited
to, without limitation, damages of any kind) arising in contract,
rot or otherwise, from the use of or inability to use the
magazine, or any of its contents, or from any action taken (or
refrained from being taken) as a result of using the magazine
or any such contents or for any failure of performance, error,
omission, interruption, deletion, defect, delay in operation or
transmission, computer virus, communications line failure,
theft or destruction or unauthorized access to, alteration of, or
use of information contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom the NEW
PCLinuxOS Magazine has no control or connection, business
or otherwise. These sites are external to the NEW
PCLinuxOS Magazine and by visiting these, you are doing so
of your own accord and assume all responsibility and liability
for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The NEW PCLinuxOS Magazine accepts no responsibility for
the content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

DisclaimerInternational CommunityPCLinuxOS Sites
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http://pclinuxos.org.pl/
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by Meemaw
In the second part of our Scribus series, we did a
basic header, and got started putting news stories
into our newsletter. Since it is a newsletter, we
should have lots of text frames that contain our
stories. A few extra bits of knowledge will help make
our newsletter easier to assemble and, hopefully,
easier to read.
Title Shadow
When you created your
heading 'Newsletter' or 'Club
Newsletter' or whatever you
chose, I'm sure you found the
button in the text
configuration that would
automatically put a drop­
shadow on your text. The line
of buttons in Color & Effects
has Underline, Subscript &
Superscript and several
others, even Reverse. The
next to last button toward the
right is Drop Shadow.
However, we have found that
some of the pdf readers (kpdf for sure) have
problems loading and printing pdf's with the shadow
made in this manner. Some computer lock­ups have
even occurred. So, instead of just clicking the 'Drop
Shadow' button, we do ours a little differently. It
might take a few more seconds, but it is just as easy.
Make your text frame and get your title in it the way
you want it to look. My header at work is color, but
the background around the text is white, so my title
will be black with a gray shadow. After you get your

title the way you want it, click on Item > Duplicate.
Now you have two text frames with the same thing in
them. If the first was black, change the second one
to gray (or whatever color you want to use. For the
magazine, one is white and one is black.) Select the
one you want to be in front, and in Properties, click
on the up arrow with the line across the top of it
(bring to top). Note what the X­pos and Y­pos of
your text is, then choose the other text frame. Your
drop shadow can be in any position and as close or
as far away as you wish, just by manipulating the X­
pos and Y­pos of the other text.

My drop shadow here is done by adding 0.03 inches
to the X­pos and 0.02 inches to the Y­pos of the top
text. That makes the shadow underneath and to the
right of the main text. With some experimentation,
you can get them in many positions, close to the
main text or farther away, whichever you want. After
you get them positioned, you should group and lock

them so they won't get moved by accident. (You
could actually move these off the page and get them
positioned there if you wish. After they are locked
together you can move them back onto your page
and position them properly in the header, then lock
them to the page.) Save your work.
Text Flow
If one of your articles is rather long and it needs to
continue in another column or on another page, you
can do that with the Text Flow button.
First, you need to have
the article's text frames
already in place. (In the
illustrations, the text
frames have borders around them for visibility.) In
my newsletter I generally have two columns. Choose
the first text frame, then open the story editor screen
and put in your text. When you click the ok button
(checkmark) your story editor will close and you will
see your text in the frame. Since you have too much
text for that one frame, you will see a box with a red
X in the bottom right corner of your frame.

Using Scribus, Part 3: Text, Text, TextUsing Scribus, Part 3: Text, Text, Text
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Click on the Text Flow button (hovering your mouse
over it will show 'Link Text Frames'), then click the
text frame where you want the rest of your text. You
should immediately see your text in that frame.

You can flow it to yet another frame, or resize the
two frames you are using, whichever works best for
your document. Just remember to click the frame
you are going from, then the Text Flow button, then
the frame you are going to.
Fonts
While we are talking about text, it might be a good
idea to mention that, although you want to 'dress up'
your newsletter, you probably shouldn't make it too
'busy'. What I mean is that there are thousands of
fonts you can use, some plain
and some fancy, but it's a
better idea if you stick to two
or three readable fonts for
most everything, and only use
one or two 'offbeat' fonts to
draw attention in a certain spot
in your newsletter. That way
you preserve the flow of the
newsletter while giving it an

added spark here and there. In my work newsletter, I
have used a couple of different fonts for article titles,
but left the standard font for the body of each article
so it's easy to read. The title font draws the reader's
eye, and then they read that article easily. Using a
different font for each article may sound good, but it
would distract the reader too much, so it is probably
best not to do it. After all, that's why you are doing a
newsletter; so people will read it.
Next month, we'll talk about layers.

Using Scribus, Part 3: Text, Text, Text
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by Meemaw
We have learned to set up our document and insert
text and images. We have also made an eye­
catching header for our newsletter and talked more
about text frames and text flow. Now we're going to
see what can be done with layers.
One of the side windows I have open all the time is
the Layers window. Layers make the design of your
document easier. If your text is on one layer and
your graphics are on a different layer, you can
manipulate the graphics all you want and not have to
worry about moving your text frame somewhere it
shouldn't be or deleting it by accident.

I haven't added any layers to my document yet, so I
only have one, the background. For the magazine, I
generally put the text and headings on one layer and
the graphics on a second layer, OR the text on one,
the graphics on one and the headings on a third. To
add a layer, simply click the plus sign at the bottom
of the layers window. Another layer will appear in
your list, probably named New Layer 1. You can
rename the layer, if you wish, by double­clicking the
layer name and typing in a new one. I will rename
mine 'Graphics.'

Don't worry, because your text on the bottom layer
can still flow around any image you place on this
layer. In the line above the layers you'll see some
icons corresponding to checkboxes below. These
are settings for individual layers that you can
choose. From left to right, the eye icon is for visibilty
­ checking the box allows each layer to be visible;
the printer icon ­ checking it allows you to only print
certain layers; and the lock icon is for locking a layer
­ if checked, it can't be changed. The next icon is for
text flow ­ you can completely turn off text flow on
any layer. The last icon at right is for 'wire frame' ­
loading a graphic's frame rather than the big graphic
will let it load faster. The default for the checkboxes
is shown, as I very rarely change any of them.
The Scribus wiki talks about creating a single­page
flyer in more than one language. If you have text for
each language on its own layer, you could activate
the layer you wanted to see and deactivate the
others with the 'eye' or activate the print feature on
the layers you want printed. The company I work for
has created a brochure that they have done in
English and Spanish: the two languages would be
on two different layers.

When you are working with layers, you have to be
careful that you know what layer is active so things
go where you want. I keep the layers window open
all the time and switch back & forth between them.
Generally, I will put in the text on its layer, then
switch to the graphics layer and start putting in the
images. As you're placing images, you can go to the
Properties window and click Shape to choose how
you want your text to wrap around your picture.
Make sure you wrap it using one of the methods
shown, or your text will be invisible under your
image.

Using Scribus, Part 4: LayersUsing Scribus, Part 4: Layers
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With the choice Frame Shape, the text will follow the
shape of the item you put in. If it is a circle or heart,
you may have some interesting text flow! Using
Bounding Box, which is what I use the most, Scribus
will 'draw' a box around your item and flow the text
around that. Since nearly all of my graphics are
rectangular anyway, this works well. The next
choice, Contour Line, does the same thing but puts
a dotted line border around your graphic.
Once you get your text and graphics inserted and
arranged, you can always add another layer for your
titles, captions and hyperlinks, if any.
On a side note, a recently introduced bug in Scribus
prevents text flow around grouped objects. Once
working up through Scribus 1.3.5, the Scribus
developers have told us in their IRC channel that the
new bug won't be fixed until Scribus 1.5, which is
literally 11 releases away, with no further
explanation. Fortunately, you do have a couple of
"work­arounds" to this problem, if you find the need
to have text flow around grouped objects. First, you
can ungroup the grouped object, and set the text to
flow around the largest element of the group. The
second way is to place an "invisible" polygon shape
(one that has no fill or border color) around the
grouped object, and have the text wrap around that
invisible polygon.
After you use Scribus for a while, you will
undoubtedly develop your own way of using layers.
Depending on the complexity of your document, you
could have as many layers as you can comfortably
handle. Experiment all you want!
Next month we'll catch up with a few other important
features.

Using Scribus, Part 4: Layers

Are viruses, adware,
malware & spyware
slowing you down?
Get your PC back to
good health TODAY!
Get

Does your computer run slow?
Are you tired of all the "Blue Screens of
Death" computer crashes?

Download your copy today!

LinPC.us

Looking for an old article?Can't find what you want? Try the

PCLinuxOS Magazine'ssearchable index!
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http://www.linfx.com
http://www.linpc.us
http://www.distrowatch.com
http://pclosmag.com/html/sorted.html
http://www.oneclicklinux.com


13

by Meemaw
We've learned much in our short time with Scribus!
By now you should have most of your newsletter
finished, with only the finishing touches to add. We'll
cover a couple of those now, which should make
your work a little easier.
Links
Many stories now have links to
websites on them. If your story has a
website associated with it, you may
want to provide the link in your
article. While it's not hard to format in
Scribus, it is not readily apparent on
the screen. In the default layout, you
will see a pair of 'shoe­prints' on the
left side of your window.
Click on them, and form a frame
around your web address. It will look
just like a text frame. Double­click on
it and a link window will appear. You

should choose 'External Web­Link in the drop down
box, and you will see a blank for your web address.
When you get the correct address entered you can
click OK. Also remember to lock your frame so it
doesn't go anywhere. NOTE: If you want the text to
be blue or something other than black, you will have
to change the color of the text in your story editor
and not in this window. It doesn't show it in the
illustration, but you need to make sure your web
address has the appropriate web service to use;
http:// for web pages, ftp:// for ftp sites, mailto: for
email addresses.
The toolbar up the side is the PDF toolbar. You can
insert checkboxes, button boxes and more from
there. Unless you are designing a fillable form or
something that requires checkboxes or buttons, you
may not use many of the tools there, but it is great
that they are included.
Scrapbook
If you do several newsletters, you may have some
graphics you use all the time, although not in the
exact same place every time. Scribus provides a
Scrapbook to store some of these graphics. Under
Window > Scrapbook, you can build a collection of
your most often­used graphics, kept right there for
your convenience. When you first open it, you will
have an empty window. However, as you use
something and
decide to save it
you can select it,
right­click on it and
choose 'Send to
Scrapbook'. (The
default is called
Main.)

You will be asked to name your item.

If you created an album besides 'Main', you also
need to save it. Next time you need it, it will be
there, and you can simply find it and drag it to your
project.

My newsletter uses
the company logo
somewhere on one of
the pages, and for
this magazine, we
display several ads.
Those graphics don't
change, so they are
saved to the
Scrapbook so that we

can just choose the one we want and drag it into the
document wherever we want to put it. You could
save four graphics representing the seasons, and

use each somewhere in your newsletter
during that season. I'm sure you have
even more great ideas!
Next month we'll look at templates and
master pages.
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by Meemaw
If you do a document on a regular basis, it might be
a good idea to save it as a Template or a Master
Page. With my newsletter at work, I use the same
basic layout every time, with the title page being of
one design and the remaining pages being different.
I have saved the basic layout as a template, which I
can open from the start screen (remember one of
the tabs said 'New From Template'). If I want to
change anything in the basic layout, I can do it
because it's a template.
On the other hand, here at the magazine, we use a
Master Page so every page of the magazine has
exactly the same border at the top and bottom. You
can always cover those borders with
something else, but the master page is
locked so it can't be altered easily.
Both the template and the master page
are handy items to have, each very
useful in its own way.
Templates
Making a template is the same as doing
a one­page or several­page project.
The difference is, in your newsletter or
magazine, you will fill the text frames
with your stories. In your template, you
will place the text and graphics frames
you plan to use most of the time, but
won't enter any text into the story editor
or any images into the image frames.
The first page of my newsletter looks
very much like the image here. ­­­ >

My first page generally has the main story in the
frame on the right, one small story or
announcement in the rounded frame at the
bottom left, and the table of contents of the
newsletter in the open space at top left. My
second, third and fourth pages have a different,
smaller header than the first page, but are more
identical to each other, and have the page
numbers already on them. I generally use the
same page format as page 1, with a narrow
column on the left and a bigger column on the
right, and one of the stories on each page having
the rounded frame around it. Since the reader’s
eye will be drawn to a darker or thicker frame, I try
to place more important notices or stories in that
frame.

Since I use this format
most of the time, I have
made it into a template.
To save it as a template,
just choose File > Save
As Template... You will
be asked to name your
template. If you use
something frequently,
you should save it.
To use your template,
simply open it, and then
resave it with the title of
your present project. My
newsletters are
generally saved as
“Company_Newsletter_
June2011” or something
similar. After you have it
saved, create!

I found a couple of sites that have templates you can
download for yourself:
http://scribusstuff.org/
http://www.oak­tree.us/2010/08/21/modern­
templates/
http://www.scribustemplates.org/ (seems to be a site
in a state of change)
Master Pages
On the other hand, maybe you have a specific page
design you want to apply to some or all of the pages
of your newsletter. Maybe you aren’t sure how many
pages your newsletter will be, or what will be on
each page. My newsletter is four pages every time,
and the pages, while being the same general
design, are not identical, and can be changed any
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time I choose to change them.
The magazine, however, has the same design for
every page, so when several people work on it, the
finished product has a unified look. The magazine
uses a Master Page. It is a one­page design that
has the header and footer and the columns already
established.

(Looks pretty empty, doesn’t it?)
To do a Master Page, you open a new document,
format it the way you want it (margins, orientation &
so on), then choose Edit > Master Page. You will get
a small window which has several buttons (New,
Copy, Import and Delete) plus one entry, Normal.
Since you are creating a new page, click on the first
button on the left (it should say ‘New’ when you
hover your mouse over it.) Another small window will
pop up, asking you to name your brand new master
page. I named mine MeemawsOwn, but you should

name yours something more appropriate for you.
Click OK. Now you will see the name of your new
master page in the list. (below)

Make sure it’s highlighted, because that’s the one
you want to edit. Leave this small window open!
That is how the program knows you are editing that
master page.

Now, put in the header and footer information you
want to have on that page. If you use 2 columns all
the time, put frames in for them. If the text should
flow from left to right through the columns, you can
put that in as well. If you always have a logo in a
certain spot, put that in and lock it down.
When you are finished editing your page, you can
click on the save button in the main toolbar, and give
your document a name. Only when you have saved
your page should you close the Edit Master Pages
window. If in the future you want to alter your page,
you simply go to Edit > Master Pages again, edit the
page the way you want, re­save, and close again.
(below)
If you have opened a document and decide that you
want to use your master page, you can go to Page >
Apply Master Page and a window will open asking
which pages you want to
apply it to. Choose yours.
If you have a multi­page
document, you have the
option of applying the
master page to certain
pages, or all of them. It
will be applied to the
page or pages you have
designated.

Templates and Master Pages are very useful, each
in their own way. If you want to save some time in
your creation, experiment with each and develop
what works for you.
Next time, we will look at ways to give your
document a little flair.
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by Meemaw
I’m sure that by now, your newsletter or brochure
has everything it needs to be printed or e­published.
However, if you haven’t added any extras to dress
up your document a little, maybe some of these
ideas will help make your document ‘pop.’ You don’t
have to fill your pages with everything, but a few
accents here and there will make things more
interesting.
Graphics
Many of your articles probably have photos, but
what about that page with purely informational
pieces that are
graphics­free?
Sometimes the page
will have a spot or two
that look bare, even
though there are
several articles.
Sometimes you don’t
want to start another
article on that page, but
prefer to start on a new
page, and you have
room left over.
Magazines, even this
one, have ads they can
put in the open spaces,
but in your newsletter,
you may not sell ads, so
you could find some
graphics, clipart or even
logos that will fill a small
space and dress up
your document.

However, take care not to fill up every single inch
with text or graphics, or jam your articles so close
together that they are un­readable. Leave a little
‘white space’ so as not to overwhelm your reader.
White space is a design element, too.
Fonts
A font that is different from all the rest can draw the
reader’s eye. If you have a notice or announcement
you want everyone to read, you might put the title in
a different font to draw the reader’s eye to that
announcement. However, be careful, since the use
of too many ‘different fonts’ can have the adverse
effect of making your newsletter difficult to read.

In the example below, there are only two fonts that
differ from the ‘regular’ title and body fonts. They are
the top and bottom titles.
Also, if you are announcing an event you want
people to attend, make sure the “Who, What,
Where, When and Why” are in a prominent place so
your readers won’t have to search for it. I actually
read an announcement recently for a local meeting
which did NOT include the date of the meeting! If the
writer had put those items in a prominent place
rather than the body of the notice, he probably would
have seen that the date was missing. (Yes, he got
loads of calls.) In the newsletter above, I just gave
the date and location of the Annual Meeting.
However, another thing I use Scribus for is the

invitation postcards for the
same event, which will have
a section where the date,
place and time are clearly
listed. Another use is an
advertising flyer or
brochure, where the facts
should be more clearly
stated.
Borders
Borders can draw the
reader’s eye as well. You
can put a border around an
article on a page that you
want to emphasize. Some
of my newsletter pages
have two articles with
borders, but the more
important one is usually
surrounded by the darker or
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thicker border. In the example, the contest winners
are the information that I wanted to be emphasized,
so that article has the thicker border.

Borders can be any design from a very thin line to
starbursts or thick polygons. If you want some
information to stand out, use the starburst or a thick
polygon, keeping in mind not to overwhelm your
information with the border design.
Color
If you are doing a newsletter or brochure you may
want your company logo on it. Make an effort to

choose the other colors you use so they don’t clash
with the colors of the logo. That way your finished
document will look unified. If your main logo has
very bright colors, the choice of complementary
colors is especially important.
Choose your photos so they are bright enough to be
easily viewed whether the document is viewed on a
computer or printed and mailed. I have some
members that want theirs sent by email and, for the
rest of the members, it is printed in black ink on
colored paper and mailed. The photos have to be
bright and clear enough to be seen either way.
Next month we’ll examine a few more items you
need to complete your project.

Using Scribus, Part 7: Add a Little Flair!
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by Meemaw
Your newsletter is almost finished!! You have all
your articles written and in their frames, all of your
images are in place, and everything else looks good.
What else can you possibly need?

Importing pages
Let’s say you already did a one page item that you
now want to incorporate into your newsletter. How
do you combine that Scribus file with this one? In the
Page menu, you will see Import. You will get a
window asking what document you want to use,
which page(s) you want to import and where in your
present document you would like them put. Make
sure that you specify every page if you want them
all. For example, you should specify pages 1
through 2 from a two page document, unless you
are only importing one page. If you just say 2 from 2,
only page 2 will be inserted. (Maybe it’s only me that
has made that mistake!)

This is how we add the different articles to the
magazine. It’s also best if you put everything you will
be using into the same folder (Scribus files and
images). You may even have to re­add your

images... the frame will be there, plus the name of
the file, but you’ll have to tell Scribus again where
the file is located. If you are doing a big project, one
common folder will be very helpful because it will all
be much easier to find.

Page Numbers
Depending on the length of your newsletter, you
may get by with putting in page numbers by hand,
that is, creating a text frame and actually putting the
correct number into the frame. My company
newsletter has the page numbers already within the
template. But it’s only four pages every time. This
magazine is many more pages, and different people
work on the page layouts, so it’s impossible to know
which number to put on which page. However, there
are a couple of methods for inserting page numbers
in your document.
In the first method, you can insert a text frame on
each page. For a polished look, make sure the
frame is the same size and in the same place on
each page. Then when you open the Text Editor,
you will insert a field rather than a specific number.
Go to Insert > Character > Page Number. You will
see this # in your text editor. Make sure you
center it (if wanted) and format the text so it matches
your desired font.
Create the same thing on each of your pages. You
will see the page numbers appear. What’s really
great about this is that the page numbers will correct
automatically if you have to add a page somewhere
in the middle.
The first method isn’t too tedious if you only have a

few pages, but if it’s the size of this magazine, it will
take a while. The second method is to edit your
Master Page to include the text frame with the page
number exactly as done in the first method. Make
sure you apply that exact Master Page to each page
of your document. Again, as with the first method, if
you insert a page (or pages) in the middle of your
document, the page numbers will automatically
adjust themselves.

Pre­flight
While this process doesn’t HAVE to be done, we will
click on it to see what it includes. A window will pop
up listing each page of your document. Things that
may appear are pages where the text overflows, or
images that are a smaller resolution than you have
designated in your preferences. You can see that I
imported two pages and haven’t completed the text
flow to the last page.

Although not stated, it may also serve as a reminder
for you to delete any empty pages you might have.
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Creating the PDF
When you are positive that you have done
everything necessary, it’s time to create the PDF. In
the toolbar is a button that says ‘PDF’ on it (or has
the ‘A’ logo of Adobe). When you click it, a large
window will appear asking for the parameters for
your PDF.

There are seven tabs in this window. Many of the
settings are for specialized documents and many of
them can be left at default, but a description of each
tab follows.
General: This is the tab you will see first. You are
asked to give a file name and location for your PDF,
which pages you want to export to your PDF and the
compression method you want to use. You are also
asked the type of PDF you want. The compression
can be of three types (default is Automatic) and
compression rate can be from 5% to 95%. You

should choose the one that works best with your
document and the size you want to have. The
highest compression sometimes takes away from
the quality of some image files.
Fonts: Here you will see the fonts that you have
used in your documents, along with two sections
titled Embed or Outline. Generally, you want to
embed your fonts because if your document
recipients don’t have all the fonts you used, they can
still view the PDF as you created it. I send a PDF to
my printer so I won’t have to make sure I use fonts
he has or send him any extra font files.
Extras: Your PDF can actually be made into a
presentation (as in LibreOffice Impress)! The effects
for that are in this tab.
Viewer: Here you can choose the way you want the
PDF viewer configured when it opens your
document.
Security: If you want to encrypt your document so a
password is required to open it, you can do that
here. There are places for a password for you, and a
different password for the document recipients.
Color: The top selection says, “Output intended
for...” Screen/Web... Printer … Greyscale.
Depending on what you choose, there may be
another option or two to choose from. Most
everything I do is for Screen/Web. Yes, I do have my
newsletter printed, but I send the PDF in color and
he prints it in black ink. Full color printing is more
expensive than my office can afford. Many of our
members have subscribed to the eNewsletter, which
I send in color from my computer, but the rest get it
in greyscale through the mail.

Pre­Press: You can choose to have printer marks on
the document, in case it has to be cut, folded or
bound. Bleed settings are included for the same
reason, but the default is “Use Document Bleed”.
I’ve read a little about it, and it seems it’s to make
allowances in the document placement for a book
that is folded and bound so the margins are constant
throughout the book. The last checkbox is for
PDF/X­3 output, which is a standards compliant
format for professional printing.
Many times, the default settings are fine. When you
get the settings the way you want them, click “OK”
and your document will be exported. It’s generally a
good idea to open up your PDF and make sure it
looks they way you want it. You can always delete it
and do it again with different settings.

Other documents?
You can do so much more than newsletters!
Magazines, brochures, postcards, greeting cards are
just a few of the possible creations. (I even did a
custom map a couple of years ago.) Anything you
can do with any other publishing program can be
done with Scribus. Many other programs have pre­
designed templates you can open which will make
your job easier, along with tons of clipart for you to
insert. While having pre­made designs is a good
thing, I still think Scribus is better. Anything you can
set up in Scribus can be made into a template for
future use. You aren’t locked into someone else’s
idea of what looks good, and you can add your own
creativity to your projects.
Next month we’ll finish up with a few tips & tricks.
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by Meemaw & Paul Arnote (parnote)

We have gotten our newsletter created, converted to
a PDF and published (or mailed.) However, here are
a few last little things that will make the next
newsletter, brochure or magazine a little easier to
create.

Linking the Table of Contents to the Article
If you have a large newsletter or magazine, you can
link each article listed in the table of contents (of the
PDF) directly to the page where that article starts.
Just like doing a web link, use the link tool (the pair
of shoes) and draw a frame around your article
name in the table of contents. Double­clicking the
frame gives you the link window. Rather than
choosing ‘Exterior web link’, you will choose ‘Link’.
When you do that, you will see the first entry says
‘Page’. If you have all your pages in order the way
you want them, put the page number of the article
into that box and click OK.

Be sure to change
the last number in
the page positioning
from 612 points to 0
points. Otherwise,
the link will point to
the bottom of the
page, instead of the
top of the page.

Spacing for Text and Images
When you place an image, and choose the text to
wrap around the image, you will notice that the text
is usually ‘crammed’ right up against the edge of the
image. We will need to space that out a bit so your
article reads better, and it helps give your document
a more polished appearance. There are a few ways
to do this, depending on where the space between
the image and text is located.
For the first method, note the size of the image, and
place a polygon or text frame in the image layer,
with text flow around it. Then, change the size so
that it's three (3) points wider or longer on the side
you need it to space against the text. You may have
to slightly alter the position of that item to
accommodate the spacing, if it's on the left side of
an image, by reducing the X­Pos setting by an equal
three (3) points.
For the second method, if you need the extra
spacing along just one side of an image, because
the text is butting right up against one edge of an

image, the easiest way is to
duplicate the picture, change it to a
polygon (or text frame), then
increase the height or width of the
image by three (3) points. I
increased it by much more for the
purposes of this article (top right).
Finally, another way to do it is to
place a very thin invisible polygon
along the edge of the image where
the spacing is needed. You guessed
it: the height or width of the invisible
polygon (made by setting the border

and fill color to “none”) is three (3) points.
Of course, you can always increase the size of the
“border space” if you want. Just be sure to be
consistent throughout your document, so you
preserve that polished appearance and so that your
document doesn’t appear amateurish.
Remember, everything is done in the image layer.

Dropcaps and Alignment Issues
Dropcaps are occasionally used in documents. They
are done exactly like placing a small picture at the
beginning of an article, except that it's text; typically
a different font, but a much larger size and color.
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Just as with pics, you can set the alignment to the
baseline or the top of the character you use as a
drop cap.
In the example, I just
changed the first letter in
the top box to a different
font and size. If you do it
that way, it will
automatically align
everything with the bottom
of the text. On the second
example, I placed a
separate text box with the
first letter in it. (You an see
the boundaries of the text
frames.) I also defined the
text flow in the ‘Shape’
section of the ‘Properties’
window. You have to work
a little bit to line up things
as they need to be. While
it does offer a different
appearance for the beginning of a paragraph you
probably should only use dropcaps sparingly.

Groups: What’s the Best Way?
Grouping items is really the best way to make sure
something looks the same every time you use it. The
header for my newsletter is several items all grouped
together. We see the screenshot showcase in this
magazine every month, and it is also many items
grouped together. If you design something with
many parts and want to make sure they all stay
together when moved, you should group them. If you
are going to want to reuse something multiple times,

the best way to keep it is to group it first, then add it
to your scrapbook. When you reuse it and need text
flow, there are some options on how to do that.
The Scribus developers are working on fixing the
option to apply text flow around a grouped object,
but it is not “scheduled” to be “fixed” until Scribus
1.5.x (it was working up through Scribus 1.3.4, but
then stopped working in subsequent releases,
including the current one, 1.3.9). Despite the Scribus
developers being rather unresponsive to requests to
fix this problem and dragging their feet on providing
a solution (What? Another 12 versions of Scribus
before we can finally have this once­working feature
fixed?), there are workarounds.
First, you can use the options listed above to provide
that extra space around an image.
Second, you can ungroup it, and make the
background of the grouped object only have textflow
around it.

Boxes!
Everything doesn’t always have to be square! Some
of the boxes in my newsletter have rounded corners.
I think it softens the look of the document. For that
reason, you want to use them sparingly, or only on
documents that aren’t required to be very sharp and
precise. (I usually have only one on each page).
Insert the polygon where you want it to be, then click
on ‘Shape’. Towards the top, you will see a box titled
‘Rounded Corners’. You can use the up arrow to
designate the amount of rounding you want, and you
can keep clicking the up arrow until you have a
circle!

You can see the corners changing as you click on
the up arrow, so you can stop when it is the way you
want it. After you get used to the setting, you will
probably know what number you want in that box.
Notice that you can do this with shapes AND text
frames. I generally use a polygon if I want a rounded
border, and put the text frame over it. That way, my
left­aligned text is straight at the left edge. If you
round off a text frame, your text will follow the
rounding at the corners. You may want to use this
for a different look in your document. After you
experiment a little, I’m sure you will find something
that looks the way you want it to look. If you round
off the box, you can round off your text flow as well
by clicking ‘Use Frame Shape’ (but you’ll have to
experiment with the flow to make sure it looks right,
too).
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Layers, Layers, Layers … and more Layers
When I started using Scribus, it seemed like one
layer was good enough. However, as I have
continued to use it, I use more layers than ever.
Sometimes it seems like it’s more work to use more
layers, but that isn’t the case.
One of the major reasons to use more layers is that
each feature of your document (text, images, links)
are contained in one spot. This means you can’t
click and drag an image out of place if you are
adding links, and you cant move a link if you are
adding another image.
As I said in an earlier article, the company I work for
has a brochure they print in English and Spanish.
Each language is on its own layer, and the images
are on another layer. They can work on them both at
the same time and make visible whichever language
layer they need to convert to PDF.
Say they want to update the brochure with edited
text and new images. They can delete the image
layer and start again, or just replace the images in
the document with new ones. They can even have
different images in their Spanish version than they
have in their English version. That would required
another graphics layer, with the Spanish layers
visible in one PDF and the English layers visible in
the other.
We can’t emphasize this one enough! The more
layers, the better. As you can see from the example
above, it adds a lot of flexibility to your document.
Plus, in the end, it makes laying out your document
much easier and adds a lot of organization to the
process.

Workspace Arrangement
Generally, the arrangement of your workspace
depends on your screen size, but on all the
computers I use, Scribus seems to be the most
usable to me when the main document window is at
the left of the screen and the Properties and Layers
windows are at the right side of the screen. They are
the two windows you will use the most besides the
document window. All the other windows you will
use are available in the ‘Windows’ menu.

Our Chief Editor uses a slightly different
arrangement, where he has his Properties window at
the left side of the screen, the Layers window at the
right edge of the screen, with the Scrapbook window
then positioned just to the left of the Layers window.
He leaves both of the windows on the right shaded
up until they are needed. Often times, he also leaves

his Properties window shaded up until he needs to
access the data displayed there, so he can see the
entire screen when he’s laying out the magazine’s
articles every month.

The point here is to take the time to arrange your
workspace in a manner that fits best with your
workflow habits in Scribus. If you are a new user,
you might not have yet discovered your workflow
habits. There is no one “right” way to arrange your
workspace, so don’t be afraid to experiment until you
find an arrangement that best suits you.

Choices of Graphics File Formats
Some graphics formats look better than others (have
a higher image quality), and take up more space.
Others save space, and sacrifice image quality. The
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preferred graphics format is to use PNG graphics,
due to their lossless compression. In fact, the
Scribus developers recommend using the PNG
graphic file format whenever possible. Yet, due to
their lossless compression, PNG files tend to be a bit
larger than equivalent JPG files – which use a lossy
compression algorithm. The JPG lossy compression
algorithm causes small details to be dropped out of
the final image each time it is saved. The result is
that the PNG file has much better quality, but JPG
files have much smaller files sizes.
For The PCLinuxOS Magazine, we use a mixture of
PNG and JPG files. Where quality matters most (and
that is for the graphics that accompany most of the
articles you see in the magazine), we use PNG files.
However, to save space (and to help reduce the file
size of the PDF file you have to download), all of the
Screenshot Showcase files are changed to 600 pixel
wide JPG files.
While we’re talking about graphic file formats,
Scribus can import SVG vector graphic files.
However, use caution when using SVG files. Pure
SVG files can be quite small in relation to the image
information they contain. Plus, they are scalable
without a loss of image quality. However, their file
sizes can be quite large, especially if a number of
PNG files were used to help make the background
of the SVG file. Because the entire SVG file is
imported, part and parcel, into the Scribus
document, the size of your Scribus document grows
by the exact same amount. Even when you
compress the PDF output from Scribus, you’ll end up
with an enormous file size for your PDF.
A better option is to export your SVG file from
Inkscape (or other vector graphics application) to a

PNG file that is closer to the image size you need in
Scribus. Then, use that PNG file in place of
importing the actual SVG file.

Scribus Resources
Certainly, there is far more information available
about Scribus than we’ve covered here, in our
Scribus series. If you want to learn more about using
Scribus, here is a short list of additional resources
that you might find helpful:
Getting Started With Scribus:
http://wiki.scribus.net/canvas/Get_Started_with_Scri
bus
Scribus How­To:
http://wiki.scribus.net/canvas/Category:HOWTO
Scribus Links:
http://wiki.scribus.net/canvas/Scribus_Links
ScribusStuff.org:
http://scribusstuff.org/index.php?xsortmode=alpha&l
ogpage=0&xcontentmode=642&page=1 Contains all
sorts of predefined templates for Scribus, including
those for CD case inserts, newsletters, magazines,
flyers, brochures, and all sorts of other cool things.
Scribus User’s Manual: http://docs.scribus.net/
LinuxJournal.com: Go to
http://www.linuxjournal.com, and enter “scribus”
(without the quotes) into the search box. There, you
will find all sorts of articles on Scribus, written at all
different user skill levels.

Summary
As you can see, Scribus is a very capable desktop
publishing application. It’s open source and free,
which is hard to beat. Unfortunately, most desktop
publishing applications, such as Microsoft Publisher
and Adobe PageMaker, use closed, proprietary file
formats that are not well documented. As a result,
it’s virtually impossible to open the file from one
desktop publishing application on a different desktop
publishing application. This is one area in the
software arena where standards have not been
established.
We hope that all your questions have been
answered throughout this series, and that it has
spawned several other questions of your own.
Scribus is not a difficult application to use. Rather, it
requires a lot of planning and forethought.
So, unleash your inner publisher and creativity, and
enjoy using Scribus!

Using Scribus, Part 9: Tips & Tricks
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by Paul Arnote
PCLinuxOS Magazine Chief Editor

You've signed up to be a part of the PCLinuxOS
Magazine staff. There are numerous ways to
contribute. You can help edit articles. You can
create artwork. You can write articles. You can be a
"technical advisor," ensuring that the magazine
articles are technically accurate. Or, you can help
typeset the articles for the magazine. It's the latter
that we will concentrate on. NOTE: While this is the
layout that the magazine uses now, it is subject to
change.

Preliminary "Stuff"
Before we can get started on learning how to lay out
the magazine articles, we have to define the
specifications that are used in laying out the
magazine. Adherence to these specifications are
important, so the magazine has a unified and
congruent appearance from article to article.
The magazine is laid out using Scribus, the open
source desktop publishing program that is in the
PCLinuxOS repository. So, if you have not already
done so, you will need to open Synaptic and install
Scribus to your computer.
Next, you will want to have some templates.
Thankfully, there are several templates for the
magazine. While they vary in length, they are all
based on the one page template, created by me and
Meemaw. Archie Arevalo created the first template,

and it was wonderful but we have changed to a new
one. From the PCLinuxOS Magazine group on
Google Groups, you can download the one page,
four page, eight page, 12 page, 16 page, 20 page,
and 24 page templates from the group's file area. All
the templates are in the PCLinuxOS­3­Column.tar.gz
file. The only one you are required to use is the one
page template. However, all the work has been done
for you on the other templates, and they make your
life a lot easier when having to lay out articles longer
than one page. Obviously, you will want to use the
longer templates for longer articles. I have yet to
have an article submitted that wouldn't fit within one
of these templates. Using Ark, un­compress the
templates to the ~/.scribus/templates directory. Bear
in mind that the .scribus directory is a hidden
directory in your /home directory, so you will need to
enable "View Hidden Files" in your file manager
software (Konqueror, Dolphin, Nautalis, or Thunar).
When you start to lay out a new article, simply open
one of these template files as an existing document.
Before you do anything else, re­save the file with the
name you will call the new article layout. This will
prevent you from potentially corrupting your "clean"
templates. Don't worry if you corrupt them, as
they are readily available for download from the
file area on Google Groups. Alternatively, you
can mark your "clean" templates as "read only"
files, preventing you from accidentally
overwriting them and their contents.

Let's Get Started
When I open Scribus, you should have my work

area set up like in the screen shot below. I will
explain why and how you can set your work area up
similarly. In the example below, the one page
template is loaded, and you are seeing a "naked"
magazine page.
At the far right side of the work area is the
Properties dialog box. This is where you will do a lot
of work, customizing the elements of the layout
components (text, graphics, photos, etc.). Here, you
will control the positioning of the various elements
on an X (horizontal) and Y (verticlal) axis, the shape
of objects (and whether text flows around those
objects or not), the style and color of the text, the
scaling of graphics and photos, the style of line
used, and colors of various objects. I point this one
out first, because it is one of the most heavily used
dialog boxes in Scribus. This dialog box can be
easily displayed by either right clicking on a page
element and selecting Properites from the pop­up
context menu, simply by just pressing F2, or by
choosing the Scribus menu Windows » Properties.
At the upper left corner is the Alignment &
Distribution dialog box. We can use the tools in it to

help us align objects.
We'll discuss it further
later on. You can display
this dialog box easiest
by choosing the Scribus
menu Windows » Align
& Distribute.
At the lower left corner is
the Layers dialog box.
Certainly, we can create
the layout all in one layer
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and not have to worry about layers. My first few
attempts at laying out the magazine articles was

done that way. And, without any doubt, it can work
just fine that way. But, the more you use layers, the

more you appreciate them. Typically, you will have
the text in the layer that is usually labeled
"Background." I then create a separate layer for the
article headline and page sub headings, another for
photos and graphics, another for links, etc. I think
you see the pattern. This helps you focus on one
element of the layout at a time. It also has the added
benefit of protecting your work from "accidental"
slips of the mouse cursor. This dialog box is
displayed by either selecting the Scribus menu
Windows » Layers, or simply by selecting F6. The
way the Layers dialog box appears (in the graphic
on the previous page) is how I always set up my
layers when I am laying out the articles for the
magazine.
At the center of the window is where most of your
work will occur. At the top, where it is blank is where
the article headline goes. The larger grey boxes
below the headline is where the body of the text for
the article go, as well as any graphics that
accompany it. At the lower right of the center work
space, is the blue ring. This is where the page
numbers go when final assembly of the magazine
occurs. Unless you are doing the final assembly, you
will not be doing anything inside the blue ring.
One thing that you might notice early on, is that the
units of measure with the magazine templates
defaults to points, abbreviated pts. Points is the
standard measurement in the publishing world for
defining the size of type. So, before we can go much
further, we need to know what the "standard"
magazine measurements are in the template.
Under the X, Y, Z tab of the Properties dialog box,
we will find the sizes of the following elements.
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Headline:
X­Pos: 30.00 pt
Y­Pos: 40.00 pt
Width: 732.00 pt
Height: 40.00 pt
Rotation: 0.00
Left Column Text Box:
X­Pos: 25.00 pt
Y­Pos: 95.00 pt
Width: 235.00 pt
Height: 438.00 pt
Rotation: 0.00
Center Column Text Box:
X­Pos: 278.50 pt
Y­Pos: 95.00 pt
Width: 235.00 pt
Height: 438.00 pt
Rotation: 0.00
Right Column Text Box:
X­Pos: 532.00 pt
Y­Pos: 95.00 pt
Width: 235.00 pt
Height: 438.00 pt
Rotation: 0.00

Multi­Column Widths:
1 Column: 235.00 pt
2 Column: 488.50 pt
3 Column: 742.00 pt
Under the Text tab of the Properties dialog box, we
can further define the attributes of the text placed in
their respective places on the page.

Headline:
Font: Bitstream Vera Sans
Style: Bold Oblique
Size: 30.0 pt
Line Spacing: Automatic
Scaling Width of Characters: 100.0%
Offset to Baseline of Characters: 0.0%
Manual Tracking: 0%
Scaling Height of Characters: 100.0%
Color of Font: White
Align Text: Center
NO Shadowed Text
Page Sub Heads:
Font: Liberation Sans
Style: Bold
Size: 14.0 pt
Line Spacing: Automatic
Scaling Width of Characters: 100.0%
Offset to Baseline of Characters: 0.0%
Manual Tracking: 0%
Scaling Height of Characters: 100.0%
Color of Font: White

Align Text: Right
NO Shadowed Text
Body Text:
Font: Liberation Sans
Style: Regular
Size: 10.0 pt
Line Spacing: Automatic
Scaling Width of Characters: 100.0%
Offset to Baseline of Characters: 0.0%
Manual Tracking: 0.0%
Scaling Height of Characters: 100%
Color of Font: Black
Align Text: Left
Are you feeling overwhelmed? DON'T! You most
likely won't have to mess with many of these
settings. However, to insure that the magazine has a
uniform and coherent appearance, we need to list
the specifications. And, nearly all of the articles in
the magazine will need to adhere to these
specifications. On occasion, there will be some
deviation from these specifications, but that will be
decided on a case­by­case basis by the magazine's
chief editor.
Often, the headline font size will vary, and will be
adjusted (downward only in size ... we don't want
SCREAMING headlines) to allow a desired headline
to fit.
On another note about the headline, did you notice
the last item under the definitions that appear in the
Text tab of the Properties dialog? It says "NO
Shadowed Text." I need to explain why. While it may
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be tempting to allow Scribus to create the shadowed
text, problems arise whenever the end user attempts
to print out a page with KPDF. It SEVERELY slows
down the print rendering, often to the point of locking
up a user's computer. So, it's best to avoid its use.
We can easily create a "faux" text shadowing that is
much easier to render, and that does not lock up a
user's computer.
To create the text shadowing ourselves, you will first
need to click on the headline text. Immediately, you
will notice that the headline will be surrounded by a
broken­line red box, with sizing handles at the
corners and at the mid­points. Now, from the Scribus
menus, select Item » Duplicate. You will see a copy
of the text appear. Under the X, Y, Z tab of the
Properties dialog box, change the X­Pos setting to
33, and change the Y­Pos setting to 43. Under the
Text tab of the Properties dialog box, change the
text color to Black. Then, back under the Scribus
menu, select Item » Level » Lower. And that's it – we
have our shadowed text! Trust me – it's a lot easier
than it sounds. Just follow the steps.
Since we now have two objects that are inextricably
linked to produce our shadowed text, it's a good idea
to group them together and lock them. The easiest
way to group them together is to use the Scribus
selection tool (the arrow on the tool bar at the top of
the screen). Click and drag your mouse to
encompass the two items. This should cause both
items to be highlighted with the red broken line box.
From the Scribus menu, select Item » Group. Now
both items will be grouped into one single item.
Right click your mouse on the newly grouped item,
and select "Is Locked" from the pop­up context
menu to lock the item in place.

Placing the Text
Now this part is very easy. Simply left click within the
first column (the left column) on the first page, and
select "Get Text" from the context menu that pops
up. This will allow you to select text from a file on
your computer. By far, the best results come from
using plain, ordinary text (*.txt) files. While you can
import the text from an OpenOffice Writer file, you
end up adding an additional layer of complexity due
to the formatting in the OpenOffice Writer file. My
motto, when I was teaching, was KISS ... Keep It
Super Simple. Using plain text files is the most
simple way, and works exceptionally well.
Since the templates have the text flow from text
frame to text frame predefined for you, the text
should flow from one text frame to the next,
seamlessly.
Once you have the text placed in the text frames, it
is possible to edit that text and change its
appearance. While you can perform minor edits
within the text frame itself (such as misspellings,
punctuation, etc.), it's often much easier to perform
the text edits en­masse. Such edits as changing the
style of portions of the text are much more easily
done by right clicking on a text frame and selecting
"Edit Text" from the context menu that pops up. This
will open up an Edit Text dialog box, with the text
preloaded into it. Now, simply highlight the text in the
dialog box that you want to change the style of (say
you want to make the byline of an article bold), and
change the font to Liberation Sans Bold. The exact
same thing applies if you want some text to appear
as italics, only you would choose Liberation Sans
Italic as the font to use to display the highlighted text

with. You can do a similar thing with color, although
colored text must be used sparingly. The default
color of the text for the body of the magazine articles
is black, and for the most part, should remain black
to maintain and increase readability. One such
example is maintaining readability for those readers
who may experience color blindness.

Graphics, Screenshots, Quotes
and Photos
Endless pages of text is, in a word, boring. Just take
a look at any technical or scientific article. Page after
page of nothing but text makes the pages appear
very gray, and lack visual appeal. Without anything
to break up the grayish appearance of the text,
there's nothing to anchor the eye and people tend to
lose their place much more easily, making reading
more difficult and decreasing comprehension.
Typically, it takes a very disciplined mind to be able
to read page after page of grayish text and maintain
a high level of comprehension. This is why, in other
publications (like magazines and textbooks),
frequent use is made of other graphical elements
like charts, graphs, screenshots, and photographs.
Plus, the old adage "a picture is worth a 1,000
words" is true, as adding other graphical elements
help improve comprehension.
Some articles don't lend themselves well to
graphics, especially if you are attempting to present
a concept or idea. Often, concepts or ideas are just
that – conceptual, and don't have any physical
representation, or at least are difficult to represent
with any kind of physical representation. In those
cases, it's possible to break up the grayness of the
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text by pulling out quotes from the article to display
as an extra graphical element, displayed in a larger
font size in a complimentary font face.
In any case, whether we are adding graphics,
screenshots, photos, or quotes, the method is the
same. We want to add the visual element and have
the text flow around it. (Don't forget that we are
adding things in layers, so you will place these visual
elements in their own layer.) This is also where
knowing the template measurements is important.
So the X­Pos, Y­Pos, and column width
measurements (in the X, Y, Z tab of the Properties
dialog box) take on some added importance.
For example, if we want to place a photo or
screenshot in the upper left column, we will want the
object placed so its X­Pos is 25, its Y­Pos is 95, and
(if the photo or screenshot is to only be one column
wide) the width of that object is 235 pts. The easiest
way to achieve this is to manually adjust the values
in the Properties box. Simply select the image tool
from the Scribus toolbar, and click and drag to the
object's approximate size. Use the values in the
Properties dialog box to refine the measurements.
You should now see a marker on the screen for the
new object. If it's an image, right click on it and
select "Get Image" from the context menu. Point to
the file you want to use and double click it (you may
have to change to the directory where you've stored
your images). Go to the Image tab in the Properties
dialog and select "Scale To Frame Size." The image
will be automatically scaled to fit into the space
you've defined. By default, the image will be scaled
proportionally, so that the image doesn't appear to
be distorted. You may need to make some slight

adjustments in the image frame (typically, either
lenghen or shorten the height) to fill the space you
have in mind for the image. Right click on the image
frame, and select "Adjust Frame to Image" from the
context menu that pops up. Next, click on the Shape
tab in the Properties dialog, and select "Text Flows
Around Frame." Magically, you will see the text shift
and adjust to flow around the new image frame.
Were you to do this with a quote, you would select
the text frame tool from the Scribus toolbar, and you
would see a text frame, instead of an image frame.
You would still select the Shape tab in the Properties
dialog box, and select "Text Flows Around Frame" to
get a similar effect. You would then specify the text
to display, along with the font size, font face, and
font style in the Text tab in the Properties dialog box,
instead of the image tab. As a shortcut, after
defining the text frame, right click on it and select
"Edit Text" from the pop­up context menu, and
simply enter the text there, making all the changes
there at once. This is the same method that I use
when creating captions for images.

Page Sub­Heads
If the article you are typesetting (yes, that's what you
are doing) is longer than 1 page – and most articles
are – each subsequent page will need what I term a
page sub­head. This is a smaller sized headline in
the upper right corner of the page, with the same
text as the main article headline, in most cases. The
page sub­head should be 14 pt size, using the
Liberation Sans font, boldface, white in color, and
right aligned. Again, do NOT use Scribus' shadow
text setting. In fact, the page sub­heads have no

shadowing whatsoever. The page sub­head exists to
help keep the reader oriented as to what article they
are currently reading.
The Y­Pos will always be 30 pt. The X­Pos, along
with the width, will alter on a case by case basis,
varying with how long the text is. To get proper
alignment, the right edge of the page sub­head must
align with the right side of the right text column. The
easiest way to do this is to first click on the right
column, then hold down the Shift key on the
keyboard and select the text frame that contains the
page sub­head. Next, from the Alignment &
Distribution dialog box, select the right­alignment
button (see graphic. It's the fourth button from the
left in the top row of buttons.). Be sure that the
"Relative To" setting is set to "First Selected" before
attempting the alignment. See, I told you we'd talk
more about the Alignment & Distribution dialog box
later on (now).
After you get the first page sub­head aligned, you
can streamline the process by noting the X­Pos
measurement (remember, the Y­Pos will always be
40.00 pt). Now, just highlight the page sub­head,
right click, and choose "Copy" from the pop­up
context menu. Move to the next page, right click in
the page banner, and select paste. Highlight the
copy by clicking your mouse on it, then directly enter
the same X­Pos measurement as the first, and make
the Y­Pos measurement 30.00 pt.
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Finishing Up
By this point, you should be pretty much done with
the layout of the magazine article. Now, it's time to
package everything up for the final assembly of the
magazine, which will be done either by the chief
editor or someone he designates. That person will
not only proof read the article again, but will also pay
close attention to insure that all the style rules for the
magazine layout are followed. Then, they will
assemble the individual articles into the one,
common PDF file that you have come to expect for
the PCLinuxOS Magazine.
First, we need to make sure all the files you used in
the page layout are available to be delivered to the
final assembler. To do this, from the Scribus menu,
select File » Collect For Output. You will be
prompted to pick a directory to place the output files
into. I recommend creating a separate directory for
each magazine article. Once you click on OK, you
Scribus will place a copy of each of the page
elements into that one directory.
Next, it's time to create a PDF of your layout. Select
the PDF icon on the Scribus toolbar, and you will be
presented with the PDF Export dialog box. We will
be creating the PDF file to be compatible with PDF
version 1.4 (right side of the dialog box, about 1/3 of
the way down). Towards the bottom of the General
tab, we need to change Compression from
Automatic, to None. Using compression makes the
PDF file load very, very slowly in KPDF, so we want
to avoid its use. Under the Fonts tab, we want to
embed all the fonts used in the article to create the
PDF file. This insures that readers viewing this on
computers that may not have all the included fonts

installed on are able to view the document as it was
intended to be viewed. Like it or not, there will be
users who will be viewing the magazine on a
Windows computer (possibly while at work), and
Windows will not have the free open source fonts
installed; hence, it's difficult to predict the results the
reader will get on a "foreign" computer.
Finally, change the directory where the PDF file is
stored to the same directory used for the Collect For
Output step. Then select Save.
Once you have the PDF file created in the Collect
For Output directory, compress the entire contents of
the directory into a tar.gz file. Then, upload the
resulting tar.gz file to the magazine group's file area
(maximum file size for upload is 10 MB).
There you have it. A step by step guide to how to
layout articles for the magazine.

Hints & Tips
Make liberal use of layers.
After you have elements placed on the screen, lock
them in place by right clicking on the item and
choosing "Is Locked" from the pop­up context menu.
Group related objects together.
Don't try to position things precisely with the mouse.
Instead, use the X, Y, Z tab of the Properties dialog
box. It's much easier.

Screenshot Showcase Layout:
1) Copy the header from the page, and fit it
PRECISELY (width­wise) in the remaining two
columns.
2) Make the "header" deeper, to precisely fill the
column height (two column should be 488.50 pt
wide, 438.00 pt high, XPos = 278.50 pt, YPos =
95.00 pt)
3) Place headline (max 30 pt) at top of two column
block, just as we do for the main headlines, using
Bitstream Vera Sans Roman Oblique. Duplicate the
headline, re­do the positioning, and create your
headline shadow.
4) Place a 2 pt line under the headline, after you
have created the headline shadow.
5) Position an image frame within the colored block
so that (initially) there is a 5 pt "margin" on both
sides (L and R).
6) Right click on the image frame, and select "Get
Image." Choose your image (should have already
been resized, either with Kim or GIMP to 480 px
wide).
7) If necessary, re­center the image within the color
block.
8) Add text frame under image, same width as
image. Use Liberation Serif, 10 pt, Bold Italic, right
aligned with the right edge of the image. Place
posters name, date, and desktop
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environment/version. You have probably noticed that
I have all that info in the file name of the images.
Creating hyperlinks in Scribus:
1) You need to change the text color to blue
yourself, because Scribus won't do it.
2) On the Scribus PDF toolbar, there is an icon with
two "shoe­prints" on it. Click on it, and draw a tight
rectangle around your blue text.
(If the PDF Toolbar isn't visible, click on Windows in
the menu bar, and at the bottom make sure PDF
Tools has a check mark in front of it. Mine shows up
to the right of the page I'm working on.... you might
have another window over it.)
3) Double click the rectangle you just drew on the
screen.
4) At the top of the dialog box that appears, select
"Link To External Web Site."
5) Then, enter the URL in the entry box in the middle
of the dialog box. Then click OK.
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PCLinuxOS Magazine Chief Editor

Headline:
X­Pos: 30.00 pt
Y­Pos: 40.00 pt
Width: 732.00 pt
Height: 40.00 pt
Rotation: 0.00
Left Column Text Box:
X­Pos: 25.00 pt
Y­Pos: 95.00 pt
Width: 235.00 pt
Height: 438.00 pt
Rotation: 0.00
Center Column Text Box:
X­Pos: 278.50 pt
Y­Pos: 95.00 pt
Width: 235.00 pt
Height: 438.00 pt
Rotation: 0.00
Right Column Text Box:
X­Pos: 532.00 pt
Y­Pos: 95.00 pt
Width: 235.00 pt
Height: 438.00 pt
Rotation: 0.00
Multi­Column Widths:
1 Column: 235.00 pt
2 Column: 488.50 pt
3 Column: 742.00 pt

Headline:
Font: Bitstream Vera Sans
Style: Bold Oblique Size: 30.0 pt
Line Spacing: Automatic
Scaling Width of Characters: 100.0%
Offset to Baseline of Characters: 0.0%
Manual Tracking: 0%
Scaling Height of Characters: 100.0%
Color of Font: White
Align Text: Center NO Shadowed Text
Page Sub Heads:
Font: Liberation Sans
Style: Bold Size: 14.0 pt
Line Spacing: Automatic
Scaling Width of Characters: 100.0%
Offset to Baseline of Characters: 0.0%
Manual Tracking: 0%
Scaling Height of Characters: 100.0%
Color of Font: White
Align Text: Right NO Shadowed Text
Y­Pos: 30.00 pt
Body Text:
Font: Liberation Sans
Style: Regular Size: 10.0 pt
Line Spacing: Automatic
Scaling Width of Characters: 100.0%
Offset to Baseline of Characters: 0.0%
Manual Tracking: 0.0%
Scaling Height of Characters: 100%
Color of Font: Black
Align Text: Left
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